
A BEGINNER'S GUIDE TO SPREADSHEETS: EXCEL 
 

A. Introduction 
 
[note: These instructions, except where noted, are for the use of Excel on PCs. There are differences in 
behavior and use on Macs, but most of these are minor and will probably be obvious to regular Mac 
users. However, file structures for various versions of Excel are sometimes NOT compatible. The 
message? Be careful or you might lose your work.] 
 
GETTING STARTED
 
Double-click on the Microsoft Excel icon and Excel will start initializing. Wait for the word Ready in 
the lower left-hand corner before beginning to work. 
 
THE SPREADSHEET
 
As you will see on the screen a spreadsheet consists mainly of a grid of cells arranged in numbered rows 
starting with 1 at the top and also in columns, beginning with A at the left: 
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A cell is a slot for information which may be either text (words), numbers, or mathematical formulas. A 
spreadsheet is perhaps best thought of as a phenomenal scratch pad on which each little cell is a 
sophisticated calculator which is able to display both calculations as well as notes describing them. As 
such, it is a powerful tool which to some extent eliminates the need for programming skills in attempting 
mathematical modeling. It is also able to relieve the tedious task of repetitive calculation--something for 
which any student should be grateful! 

 

 
WINDOWS CONVENTIONS AND EXCEL
 
You can easily move around the cell grid by using the arrow keys on the keyboard. PageUp and 
PageDown will move you vertically through screens of cells quickly. To move horizontally by screen 
widths, hold down the Alt key while pressing PageUp or PageDown. You can scroll through the cell 
grid by moving the mouse pointer [while on the cell grid the mouse pointer usually looks like a cross as 
opposed to an arrow] to the scroll bars on the right hand side of the screen and the bottom right corner. 
Positioning the pointer on the arrow head and pressing the left mouse button will make the grid scroll 
(try it!). You can also position the pointer on the square marker box within the scroll bar and drag it to 
another position by holding down on the left mouse button as you move it. 
 
To move to the beginning of the sheet (i.e., A1), you can press Ctrl-Home on the keyboard (hold down 
the first key while pressing the second).  
 
 
 



In the course of developing a spreadsheet you will frequently need to select certain cells or a region of 
cells. The currently selected cell has a bold border and you can select any cell by moving the mouse 
pointer to that location and pressing the left button. To select a series of cells (row or column), position 
the mouse pointer on the first cell you want, press the left button and hold it as you drag through the 
cells you want to select. They will be blackened. Release the mouse button when you reach your 
destination. 
 
To select a block of cells, follow the  procedure for selecting a column but move diagonally across the 
cells to the opposite corner of the block you want selected.  
 
To select non-contiguous areas, hold down the Ctrl key as you make the selections. 
 
To select an entire row or column click on the number or letter marker. To select the entire sheet, click 
on the "all" button (upper left hand corner where A and 1 meet.). 
 
Selection can also be done from the keyboard, moving to the first cell you want using the arrow keys 
and then holding the Shift key down as you use the arrows keys to highlight the area you want.  
 
To cancel a selection, simply click the mouse pointer on a non-selected area. 
 
Throughout this tutorial reference will be made to the bar of icons near the top of the screen: 
 
 
 
 
These icons are like buttons which perform special tasks. Most of them duplicate functions found on the 
pull-down menus above them but allow quicker access to the command sequences. Although many of 
the icons will be discussed in these pages, it is easy to forget which little picture stands for what 
function. If you can't remember, all you have to do is pause over the icon with the mouse pointer and a 
little box will appear that tells you the function of that particular icon. 
 
Some commands are best accessed through the extensive pull-down menus that begin with File across 
the top of the screen: 

  
 
If you place the mouse pointer over one of these words and press the left button, a list of commands will 
appear below. These can be accessed in a similar fashion and some lead into an amazing array of 
options. All of which brings to mind perhaps the most important menu option: Help. There is extensive 
on-line help available from the computer along with examples of how to do specific things. When in 
doubt, by all means ask an instructor. But when on your own, try Help. 
 
MAKING CELL ENTRIES
 
To make an entry all you have to do is move into a cell and start typing (well, almost). Try typing your 
name in cell A1 (always press Enter after typing an entry--or use the arrow keys to move to another 
cell--so the computer knows you are finished). Although your name is probably longer than the current 
width of the cell all of it will appear (covering over cells to the right). Now move the active cell to B1. 
When you type anything in this cell, you will no longer be able to see all of the entry in A1, but it is still 
there. To see that is so all you have to do is move the active cell back to A1 and look in the formula bar 
which is just above the column headings.  
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If you want to display your full name in column 1 you will have to make it wider. The easiest way to do 
this is to move the mouse pointer to the line segment between A and B in the column headings. A 
double arrow will appear. If you double-click the left mouse button the column is automatically sized for 
the widest entry it contains. You can also size the column manually by holding the mouse button down 
and dragging the column border. You can also format the width of a selected series of columns by 
choosing from the Format pull-down menu the option for Column. More general formatting hints 
follow this section on entering data in cells. 
 
Entering a number is done in exactly the same way. Trailing zeros after a decimal point may not be 
displayed but you can adjust the number of decimal places displayed by using the decimal icons 
represented by these symbols: 
 

 
 
 
    increase places    decrease places 
 
To use these icons, select the cell or cells you want to format. Then click on either button to adjust the 
number of decimals displayed. 
 
Very small or large numbers that require scientific notation can be entered in a format like this: 
 
        to enter 1.08 x 10-4 type 1.08e-4 
 
If a number you type is too long to fit in a cell, you will see ###. You can change the width of the 
column to solve this problem. Special number formatting needs not covered by this brief description can 
usually be accomplished with the Format pull-down menu, selecting Cells. 
 
So far the spreadsheet is just a memo pad. But its real power lies in its ability to calculate. For that you 
need to enter a formula. Formulas are typed in much the same way as you would write them on paper 
except that you must first type an equal sign (=) so that the computer knows you are typing a formula 
and not just a line of text. Try typing this simple formula into cell A4: 
 
      =2+5 

 
The number 7 will be displayed in the cell after you press Enter but when the cell is active the formula 
you typed will appear in the formula bar below the icons. Other math symbols can be used of course, but 
you should know that three common ones are a little different for the computer. To multiply use an 
asterisk (*), to divide use the slash bar (/) and to raise to a power use the caret (^). Techniques for 
deleting, editing and special effects can be illustrated now with the information on your spreadsheet. 
 
CHANGING CELL ENTRIES
 
Suppose you misspelled (or mistyped) your name in A1. You have several options. You can delete the 
entry and type it in again. A quick way to do this is to make the cell active and press the Delete key on 
the keyboard. If you double-click on the cell then you can edit right in the cell by positioning the 
insertion point marker and using the backspace, insert, delete, etc. on the keyboard. Or you can simply 
move up to the formula bar and do the work there (this is useful if you are editing a long formula which 
is only partly visible in the cell itself). When you are finished in the formula bar you move the mouse 
pointer to the green check mark and click on the left mouse button to enter your changes (or just press 
Enter).  

I-29 



For the purpose of emphasis you may want to make an entry bold or perhaps italicize or underline it. 
You can do this by selecting the cell and then using one of the icon buttons shown below: 
 

 
 
 
      Bold  Italics     Underline
 
Since you are in A.P. Chemistry and may want to use sub- or superscripts occasionally in your text, you 
should know how to do that. In cell C3 type H2O. Press Enter and then position the mouse pointer on 
the cell and double-click as if preparing to edit your entry. Use the arrow keys to position the cursor bar 
between the H and the 2.  
 
You can select just the 2 in one of two ways: hold down the Shift key and use the right arrow key to 
move over the 2 (it is highlighted) or use the mouse pointer while holding down the left mouse button. 
Once the 2 is highlighted, pull down the Format menu. 
 
Select Cells, click on the Font tab and mark the box for subscripting. Then click on OK or press Enter. 
This is somewhat tedious, so if you have a lot of sub- or superscripting to do you might want to use the 
keyboard equivalents. After marking (highlighting) the characters you want to change, hold down the 
Alt key while typing the following: 
 
 Superscript: oee Enter 
 Subscript: oeb Enter 
 
Unfortunately there are no buttons available on Excel (as there are for Word) which will make this a one 
mouse-click process. There is, however, an add-in or macro which converts text like H2O into the 
correct chemical format like H2O. It is even clever enough to take a string like SO42- and convert it to 
SO4

2-. The macro is available on your CD and can also be downloaded from 
http://spectrum.troy.edu/~cking/ChemFormat/index.html (installation instructions available at the 
same URL). At school there should already be an icon for this function: 
 

 
 
To use it you type your formula or balanced equation in a cell and press Enter. Select the cell again and 
click on the button. 
 
Finally, alignment of text or numbers in cells or columns or rows is easily accomplished. First select the 
region or cell you want to format. Then choose from among these icons: 
 

 
 
 
    left align  center  right align 
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USING FONTS IN FORMATTING
 
The default font for the spreadsheet is Arial which you will see indicated up near the top left in a little 
box that has a pull-down menu. You may occasionally have use for some Greek letters or other special 
symbols. Most of these are contained in the Symbol font which you can select from the menu. Below is 
a table of some more commonly needed symbols and their keyboard equivalents. You can either change 
to the Symbol font and then type the symbol OR type the keyboard equivalent in the default font, select 
(highlight) the resulting letter and then select Symbol for just that character. 
 

character D a b g l m n Alt 0174 Alt 0176 Alt 0214 
symbol font Δ α β γ λ μ ν → ° √ 
wingdings 3           

[note: Mac users access the Symbol font differently and have no equivalent for Wingdings 3] 
 
B. Starting to use Excel 
 
A CALCULATION USING REPLICATION
 
Start with a blank spreadsheet by either cleaning up what you have done or select New from the File 
pull-down menu or click on the icon: 
 
 
      New Workbook 
 
Excel files are known as Workbooks and each workbook contains a number of Sheets. These sheets can 
be related to one another or completely different--it's up to you. The "active sheet" is shown by the 
highlighted tab near the bottom of the screen and you can change sheets by clicking on the tabs with the 
mouse pointer. You can name a sheet by double-clicking and supplying a name. You can also insert and 
delete sheets using, respectively, the Insert and Edit pull-down menus. A sheet can contain a 
spreadsheet, a chart (graph) or a combination of the two.  
 
For this first example we'll choose something simple like calculating the molar masses of a table of 
organic compounds. Rename the first sheet something appropriate and then meet me in cell A1. 
 
Reproduce the spreadsheet below. Note the formatting and try to duplicate it. 
 

A B C D
1 Atomic mass of H = 1
2 Atomic mass of C = 12
3 Atomic mass of O = 16
4 MM = molar mass
5
6 # of C # of H # of O MM
7 ethanol 2 6 1
8 propanone 3 6 1
9 methanol 1 4 1

10 methane 1 4 0
11 ethane 2 6 0
12 propane 3 8 0
13 ethyne 2 2 0
14 benzene 6 6 0
15 naphthalene 10 8 0

E
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Now that the data has been entered, you are ready to demonstrate computer power. Click the cell under 
the column labeled MM (cell e7) and type the following formula: 
 

=12*b7+1*c7+16*d7 
 
then press Enter (note: the cell references may be in either lower or upper case). 
 
Notice that the molar mass of the first compound, ethanol, appears in the cell and the active cell moves 
down one place. The formula, of course, says to multiply the contents of cell b7 by 12, add that to the 
contents of cell c7 multiplied by 1 and finally add on the contents of cell d7 multiplied by 16. This gives 
the integer molar mass of ethanol. You could now proceed to type similar formulas in the remaining 
cells in this column to produce a similar result for the rest of the compounds. But the power of the 
spreadsheet is its ability to do this for you by replicating the formula and adjusting it as it does so.  
 
Use the mouse pointer to make the cell containing the formula active again. Now move the pointer to the 
lower right corner of the cell. The mouse pointer should change to a small black cross. Press down the 
left mouse button and drag the mouse through the column down to the row containing naphthalene. 
When you release the button the formula will have been copied and adjusted throughout the range! 
 
Notice that in the spreadsheet you just made most of the information is labeling, i.e., it is not needed for 
the calculations. However, experience shows that good labeling produces spreadsheets that print well 
and make sense months later when you return to them--not to mention being appreciated by the 
instructor... 
 
PRINTING A SHEET
 
To print your work you can either choose the Print icon shown below or the Print Preview icon on the 
right: 
 
 
     Print    Print Preview 
 
The best choice is the second one because you have the most control over how your printout will look, 
including margins, headers, footers, portrait or landscape mode, pagination, etc. When you choose 
either, Excel will print only the active sheet.  
 
When printing sheets that contain both calculations and graphs student often end up with more printed 
than they wanted (i.e., they did some “scratch work” at the top of the sheet but don’t want that to show 
in their report) or they lose the right side of the sheet because it is too wide or they cut a graph in half 
because it happens to fall across a page break.  
 
The first problem can be resolved by setting the Print Area. Select the part of the sheet you want to 
print by dragging the mouse pointer across the range of cells while holding the left button down. Once 
this is done, from the File menu select Print Area and then Set Print Area. Now only the part of the 
sheet you have selected will print. 
 
The remaining problems are best addressed through Print Preview (which includes access to Page Setup 
otherwise found under the File menu). From there you can get an overview of the sheet, see what’s in 
and outside of the margins, move the page breaks if needed and even turn the background grid off or 
back on. 
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SAVING A WORKBOOK
 
You can save your work as you would any file. Select the Save icon from the tool bar: 
 
 
 

Save 
 
If you haven't saved the Workbook before you will be prompted for a name for the file and a drive or 
device. The file name should be something you will recognize later (i.e., avoid names like George, Lucy, 
Stud, etc.). 
 
EXITING EXCEL
 
From the File menu choose Exit or simply hold down the Alt key and type FX. 
 
STARTING A NEW WORKBOOK OR LOADING A PREVIOUS ONE FROM DISK
 
If you want to begin a new Workbook (file) on a subject unrelated to the one you are working with, save 
your current work and then select New from the File menu (or use the icon). If you are restarting Excel 
and want to resume work on a previous Workbook you stored somewhere, select the Open File icon: 
 
 
 
      Open File 
 
If you select the drive letter or device you will be shown a file list that corresponds to the Excel 
Workbooks on the disk. Select the one you want to work on. Occasionally you will need to open a non-
Excel format file. This is usually from CBL/calculator data. These files are in what is called “comma-
separated-value” format (.CSV). The easiest way to locate these files is to change the Files of Type 
drop-down menu on the Open screen to All Files. This will display everything on the drive or device. 
CSV files have a little “a” in the middle of their icon. 
 
PRODUCING GRAPHS FROM DATA
 
One of the nicest things about modern spreadsheets is their ability to manipulate data in many ways. For 
a scientist, graphing is a powerful way to discover new relationships in data. In Excel, a graph is known 
as a chart. There are two ways to produce charts. An embedded chart becomes part of the sheet with 
your data on it and will print along with the numbers or text. You can position it wherever you want on 
the sheet and size it to suit. A chart sheet contains only a chart and can be sized or printed full page. It is 
a separate sheet in a Workbook. In both cases, the charts are automatically updated if you change the 
data (!). Let's use some of Robert Boyle's original data that supported his law: "The product of pressure 
times volume of an ideal gas is constant at constant temperature; i.e., PV = constant". 
 
Boyle's volume measurements were given in arbitrary units of length because the gas was contained in 
tubing of uniform cross-section. The pressure was measured in inches of Hg. Enter the following data in 
your spreadsheet (either open a new Workbook, or select Sheet 2). 
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A B C D E

1 Boyle's Law: PV = constant
2 V: arbitrary units of length; P: inches of Hg
3 volume pressure PV 1/V
4 48 29.1
5 40 35.3
6 32 44.2
7 24 58.8
8 20 70.7
9 16 87.2  

 
 
 
 
 
 
 
 
 
 
You might wonder how I formatted that! I placed the text "volume" and "pressure" in their respective 
columns first and used those words to size the column width. Then I typed in the rest. There are a lot of 
other ways to get a similar result. You may also notice that I centered the entries in the range A3:D9. I 
did that by selecting that range and clicking on the “center” alignment button. 
 
In the column labeled PV a representative formula should be typed to multiply a4 by b4: 
 

=a4*b4 
 
Copy the formula down through the rest of the data. 
 
Next write a formula for the column labeled 1/V. This is a good time to point out that when you use the 
decimal adjust buttons to display the right amount of significant digits, the computer actually stores the 
entire number, not just the rounded version. When it does calculations it uses the entire number. So 
when you round the answers you are doing exactly what should be done when using significant digits in 
a series of calculations. That means you should always have your significant digits displayed correctly--
no excuses!!!! 
 
[you might wonder how to format a number like 1396 so that it only shows two significant digits; the 
solution is to format it as scientific notation and then use the decimal adjust buttons. To get scientific 
notation select the cell or cells then choose Format from the pull-down menus, select Cells and then 
click on the Number tab. You can select scientific notation from the list of possible formats] 
 
You can see from the values of PV that Boyle was apparently right (especially if you have your 
significant digits correct...).  Another way of demonstrating the validity of Boyle's law is to graph the 
data in some suitable fashion. The goal here is to produce embedded graphs or charts of both P vs. V 
and P vs. 1/V. The following steps will get you your first chart in Excel. 
 
1. Use the mouse or keyboard to select the x values (i.e., the column containing the volume values). You 
can select the column heading as well if you like. 
 
2. Hold down the Ctrl key and select the y values (in this case, the column containing pressure). It is 
important to remember when constructing a spreadsheet that the left-most series you select will always 
be treated by Excel as the x-values or independent variable.
 
3. Click on the Chart Wizard icon: 
 
4. In the first dialog box you select the type of graph you want (usually X-Y (Scatter)) then click on 
Next. 
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5. If you are doing this at school in the Science Resource Center a default format for the X-Y chart will 
be used and you will see this in the next screen. Excel was originally designed for business use and 
many of the defaults are inappropriate for our work (like the dreaded grey background). A copy of this 
default file for home use is on your CD along with instructions for installation. Click on Next. 
 
6. In the next step you can enter a chart title as well as axes titles. You can also make adjustments to the 
default grid if you wish and add a legend (usually only needed if you are graphing more than one series). 
After you have made your entries, click on Next. 
 
7. In this final step you can choose to have the chart embedded on the spreadsheet itself or placed on a 
sheet by itself. If you choose to place the graph on a new sheet [not this time!] it will be adjusted for 
some default printing characteristics which are included in the Science Department X-Y format. If you 
choose to place the chart on your spreadsheet, you can adjust the ultimate size and aspect yourself as 
detailed in the remaining steps. For now, place the chart on your spreadsheet. Click on Finish. 
 
8. You can position the resulting chart on the sheet by placing the mouse pointer somewhere inside and 
holding the mouse button down as you drag the chart around. You can size the chart by moving the 
mouse pointer to the mid-point of a side until a double arrow appears and then hold down the mouse 
button as you drag [I don't know why the charts always come out so lopsided, but you should try to 
square them off a little--thin slivers of graphs are NOT acceptable in a lab report.] 
 
9. You can size the chart in its current relative dimensions by moving to the lower/upper right corner, 
looking for the double diagonal arrow and dragging the mouse as above. For this course, a graph 
should NEVER be smaller than ½ page. 
 
Nitty-gritty things: 
 
10. If you are graphing your data only to see a general trend you will want to draw a smooth connecting 
line through the points. Generally, you do this when data is not linear. To accomplish this, click TWICE 
on any of the data points. A dialog box will open up in which the choice of None has been made for the 
line. Change the selection to Custom and check the Smoothed box. Then click on OK or press Enter. 
Occasionally you can obtain a better "fit" for your data by using one of the curve fitting options found 
with the trendlines. Read on. 
 
11. If you are graphing your data in order to extrapolate or interpolate from it, you will probably want 
the equation that best describes it. To do this, click ONCE on any of the data points. Then go up to 
Chart on the Tool Bar above and select Add trendline. A dialog box will open up in which you select 
the type of function (often Linear for data in chemistry, but the curves may be useful for some 
experiments); after making that selection, click on the Options tab and select Display Equation on 
Chart and Display R-squared Value on Chart [remember, the R-squared value is an indication of how 
well your data fits the selected function--the closer to 1 the better]. You can also force the line to pass 
through 0,0 if that is appropriate as well as extend it beyond the confines of your actual data ("forecast"). 
Click on OK or press Enter. The trendline is often rather thick. If you don't like the look of that (I 
don't), double-click anywhere on the line (not on a point) and a dialog box will open in which you can 
select the line weight. The next weight down is arguably the best looking. Click on OK or press Enter 
when done. 
 
 
 
 



12. If the axis increments are weird or you want finer tick-marks (the little marks between numbered 
axis markings) you can double click on the chart to select it and then double-click on the axis you want 
to change and a dialog box will open. Choose Scale and then remove the X next to Auto and type in 
whatever you want.  
 
13. You can dress up almost anything you want in this fashion. Just double-click on it and probably 
something will happen (!). 
 
14. When you are finished, click anywhere outside the chart to deselect. 
 
This basic sequence is used (pretty much) when you want to make a chart of any data. Now you want to 
try and repeat it using the 1/V data as the x-axis. But wait! There is a problem. Remember that the 
computer will treat the left-most series of data you select as the x-axis data. But P is to the left of 1/V. Of 
course, I made you do this on purpose so you could see how to move things around on the sheet. If you 
could exchange the pressure and 1/V columns that would be swell. You can do so without spoiling your 
earlier work because Excel automatically updates charts when the sheet data is changed. Here's what to 
do: 

• select the pressure column (from cell b3 to b9) 
 

 
• select the Cut icon: 
 
• make cell e3 active and select the Paste icon: 

 
Now repeat this sequence to move the 1/V column so it is between volume and PV; then move pressure 
back to column d (you could just leave it in column e, but it looks neater back in d!) 
If you cut and paste formulas be aware that Excel may try to change the cell references so that the new 
formula is calculating from cells relative to its new position, so you may need to edit a little. 
 
Now try to make that chart of P vs. 1/V and embed it on the sheet as before (how about to the right of 
the first chart?). From your chart you should be able to see why we say P is inversely proportional to V. 
 
How should the final spreadsheet look? To some extent this is a matter of personal taste. You have a 
small table of data and two graphs. The table is arguably so small that for this one time you could 
probably get away with placing the two graphs below it sizing them to fill up as much of the page as 
possible while still remaining reasonably square. Check your Print Preview. Want to turn off the grid 
(Page Setup)? If you do your table will lose its lines as well. There is, however, a little button next to the 
paint bucket which is for Borders. You can select your table of data and play with this to get an effect 
you like if you decide to ditch the grid in your printout.  
 
Save your work now if you plan to continue (and especially if you plan to quit!!) just in case something 
awful happens (like a power failure or system crash). You might also want to try printing a hard copy. 
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OTHER APPLICATIONS
 
A First-Order Reaction 
 
In this exercise you will use natural logs (a function--Excel has many), absolute references, create a 
chart sheet (rather than an embedded chart) and find the best-fit line for the data. To make the effort 
even more practical you will start with the raw data in a form you will see often this year. 
 
The thermal decomposition of gaseous N2O5 is a first-order reaction, i.e., the rate of change of the 
concentration is proportional to the concentration. Therefore the concentration decreases exponentially, 
obeying the equation: 

ln [N2O5] = -kt + ln [N2O5]o
 

where [N2O5]o is the concentration of N2O5 at time zero and k is the rate constant. 
 
First you will need a set of data. When you do experiments this year that involve numerical data you will 
frequently be submitting that data via on-line forms. You receive a confirmation in the form of an e-mail 
which contains your data as a comma-separated value stream. Below is such a data set for this exercise. 
The first value is a time in seconds, followed by the concentration (M) of N2O5, and so on. 
 

0,0.100,50,0.0707,100,0.0500,200,0.0250,300,0.0125,400,0.00625 
 
Type this data into cell a1 just as you see it above (you will be able to simply copy and paste your actual 
data from the e-mail). Once the data is entered Excel is capable of separating the numbers into columns. 
The advantage is that your data is then ready to reference in a spreadsheet and—if it was obtained from 
a confirmation e-mail—you didn’t have to type it all in yourself. This is a fairly small data set. You will 
see larger ones during the year. 
 
To separate the values into columns, be sure the cursor is on cell A1 and go to the Data drop-down 
menu. Select Text to columns. A dialog ensues in which you have a few choices to make: 
 
 1. Make sure the “delimited” option is selected (not “fixed”) 
 2. On the next box click to select “comma”; you can leave the default “tab” selected 
 3. Click on “Finish” 
 
Your data is now spread across columns A through K in row 1. Now create the table you see below, 
starting in a2, by referencing the data already in row 1. For example, cell a4 contains the formula =a1 
 
  A B C 

1 0 0.1 50
2 Decomposition of N2O5 vs. time 
3 time (s) [N2O5] ln([N2O5]o/[N2O5])
4 0 0.100  
5 50 0.0707 
6 100 0.0500 
7 200 0.0250  
8 300 0.0125  
9 400 0.00625  
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You are probably wondering about the label in c3. If you examine the function on the previous page 
carefully you will see than it can be written so as to give a simple expression with slope equal to k, the 
rate constant: 

ln [N2O5]-ln [N2O5]o = -kt  
 
    or 

ln 2 5 o

2 5

[N O ]
[N O ]

 = kt 

 
It would be possible to plot ln [N2O5] vs. time and get a line with slope k, but for the purposes of this 
exercise we will use the approach given above instead. 
 
In cell c4 you want to write a formula that will accomplish what is described in the label shown. 
Functions like the natural log require that their arguments be in parentheses, so the formula might look 
like: 

=ln(b4/b4) 
 

which will obviously give 0 as the answer (ln 1 = 0). If you drag this formula down through the cells of 
the column it will no longer be correct since the numerator is supposed to remain the value of [N2O5] at 
time 0 but it will be changed by Excel as the formula is copied. One way out of this is to simply type in 
the value 0.100 as a constant in the formula: 

 
=ln(0.100/b4) 

 
A more versatile way that you will find very useful as you use spreadsheets is to write a formula with an 
absolute reference. This is a cell reference that does NOT adjust as the formula is copied through 
different cells. Such a reference looks like this: 
 

=ln($b$4/b4) 
 
As this formula is copied into cell c5 and below, the numerator cell reference, $b$4, remains the same 
while the denominator reference is adjusted. Try it! 
 
[recall the rule for significant digits and logs as you set your decimal places in column C: the number of 
significant digits in the original value determines the number of decimal places in the logarithm] 
 
Notice that in the formula the original data in row 1 was not referenced but instead the data copied into 
the table with your reference formulas was used. This is a matter of personal preference as either will 
work. The table was built for presentation (part of a nicely constructed lab report perhaps?) but it also 
has the advantage of clearly indicating what the numbers represent for subsequent formula writing 
whereas the original data stream in row 1 is easy to get lost in. 
 
You might want to save your work now before you try creating a chart (in fact that's always a good idea 
just in case something goes very wrong).  
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We now want to plot a graph from which we can determine the value of the rate constant, k. This time, 
so you can see how it is done, we will make a chart sheet rather than embed a chart as you have done 
before. When you choose this route Excel opens an additional sheet in your workbook (in front of your 
current sheet) and plots the chart in a more or less default size. You can still do all of the things to this 
chart that you can do to an embedded chart, but you can also get a printout of just the chart without the 
spreadsheet grid, etc. If you are working at school, the chart will be neatly sized for a nice printed copy. 
 
To begin, select the data as for an embedded chart. Remember to select the x-axis data (time) first and 
then hold down the Ctrl key as you select the y-axis data. Click on the Chart Wizard icon and proceed 
as before in the creation of your embedded charts. When you finally click on Finish the chart will open 
up on a new sheet within the workbook.  
 
You will notice that the axis titles and chart title do not show subscripts or superscripts properly. You 
can fix this. After selecting the chart (click on it) you click once on the text you want to change (say the 
chart title).  Black handles appear around it. Now click once more within the black handles and the 
cursor will appear. You can move it using the arrow keys, use backspace, delete, etc. More to the point, 
you can select text or part of the text and apply formatting like super- and subscripts just as you would 
with regular text. The y-axis title even rotates when you do this so you can edit it! When you are 
finished, it returns to the vertical position. 
 
Once you have your plot properly labeled, it is time to find the best-fit line. In Excel this is called a 
trendline and when you select this option the computer does a regression analysis of the data and tries to 
fit it to the type of function you have chosen. It will then draw an appropriate line or curve and can also 
print the function on the screen as well as give an estimate of the reliability of the function for your data. 
 
The first step is to select the data series by clicking on a data point in the chart. The data points should 
be highlighted. Go to the pull-down menus and choose Chart. Then select Add trendline. On the Type 
tab that appears you can select the type of regression analysis you think will best fit the data. In this case 
that would be Linear but take a look at the other options while you are there--you may need them 
someday. 
 
Click on the Options tab. At this point you can choose whether the y-intercept should be determined by 
the computer or whether it should be forced to zero, as well as whether to print the equation and the R2 
value which is the reliability factor. The closer the absolute value of R2 is to 1, the better "fit" the 
equation gives for your data. You can also choose to extend the trendline forward or backward past the 
limits of your data if you want a chart that shows where the trend is headed. 
 
Once your trendline is drawn you will notice that there is not much scatter in the data. This will not 
always be the case and that's exactly when the ability of the computer to draw the "best" straight line (or 
curve) among your data points comes in handy. 
 
Often we use slopes of plotted data to calculate other things. You can, of course, type the slope you see 
in the line equation into a cell and complete a calculation with it. Excel also has a function that will 
calculate the linear best-fit slope (and intercept) without plotting a graph at all. In general it is a very 
bad idea not to plot a graph because Excel can calculate a “slope” for any jumble of points and the 
data could be spread out like the constellation Orion and you would never know! However, if you 
have a graph and you want the flexibility of a slope that will update with changes you make elsewhere 
on your sheet and give a new value for some other quantity, then the function might be useful. 
 
 



Go back to the sheet with the original table of data and type “Slope =” in cell a10. If it doesn’t quite fit 
you can adjust the column width so it will. In cell b10 enter this formula: 
 

=SLOPE(c4:c9,a4:a9) 
 
The function has the general form SLOPE(y-range,x-range). You should get the same value that 
appeared on your chart. The companion intercept function looks exactly the same except for the word 
INTERCEPT. 
 
To print the spreadsheet and chart from this exercise you will need to select one sheet at a time and go 
through the printing routine as before. You can choose to print the chart or spreadsheet either in 
landscape or portrait mode by using the Page setup options. If you are doing this at school the 
spreadsheet will print in portrait and the chart will print in landscape by default. Remember, you do not 
have to print row 1 of the sheet with the data table. Simply select the part of the sheet you want to print 
and then set the Print Area. 
 
Graphing Multiple Series 
 
It is sometimes useful or necessary to graph more than one series of dependent variables against one set 
of independent variables (i.e., two sets of y-data for one set of x-data). This is done in essentially the 
same way as the previous examples except that more than two series of data are selected before starting 
Chart Wizard. For this last example we will chart the progress of a hypothetical reaction as it approaches 
equilibrium. 
 
Consider the reaction A + B  C and construct the spreadsheet shown below: 
 
 A B C D

1 A + B C
2 An approach to equilibrium
3 time, s [A] [B] [C]
4 0 0.080 0.100 0
5 20 0.050 0.070 0.060
6 40 0.030 0.050 0.100
7 60 0.020 0.040 0.120
8 80 0.015 0.035 0.130
9 100 0.015 0.035 0.130

 
 
 
 
 
 
 
 
 
 
There are no formulas to write in this case. All we want to do is visualize the process on a chart. To do 
that, select the first column as your x-data and then (holding down the Ctrl key) select the block from b3 
to d9, moving diagonally. Next click on the Chart Wizard icon. Select the usual X-Y (Scatter) plot. 
Placing a legend on a chart such as this with multiple series is a good idea. You can edit legend entries 
(if you need super- and subscripts, for example) after the chart is made. This time you will want to 
connect the points by a smoothed line when the chart is finished. You will need to do this for each of the 
three series. To do this, double-click on a data point in a series and click on the Patterns tab and then on 
Custom (under Line) and check the Smoothed line box. 
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Miscellaneous 
 
When you are writing formulas in the future you may want to use functions. Excel has a large library of 
functions that are financial, statistical, mathematical, etc. Below is a brief list of the most common ones 
you might want to use and the key words that go into formulas to represent them. 
 
ABS( )    absolute value 
SUM( )  totals range of cells; use colon to separate cells 
AVERAGE( )  totals and averages a range of cells; use colon to separate cells 
LN( )   natural log 
EXP( )   raises e to the power of the argument 
LOG( )   base 10 log 
10^   number following this is used as an exponent on 10, e.g. 10^2 = 100 
SQRT( )  square root 
 
These last two allow you to reference the slope or intercept of a best fit line without typing in the value: 
 
SLOPE(known_y’s,known_x’s)  where “known_y’s” are a range such as A1:A5; ditto for x 
INTERCEPT(known_y’s,known_x’s) where “known_y’s” are a range such as A1:A5; ditto for x 
 
Finally, don’t forget that Excel can do most of what Word can in terms of creating a finished and 
polished-looking report. Text can be typed in row-by-row, of course, although that is rather awkward. 
However, you can open a text box, place it anywhere, make it any size you want and knock yourself out 
typing away! It is also possible to highlight cells and regions with color or simply borders in order to 
call attention to something. A little of this sort of thing can go a long way so don’t overdo it.  
 
You can also create a table or even an embedded chart with Excel and then copy (just highlight the parts 
you want) and paste these into Word files. These remain “editable” as Excel files within your Word 
document in case you need to make a change. The examples in this tutorial were all made in that 
fashion. 


